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簡報大綱

• 前言

• 分析模型

• 模型建立• 模型建立

• 設定非線性鉸

• 輔助分析程式
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前言前言
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前言

• 建立建築物之數值模型

–柱ǵ梁構件→彎矩與剪力非線性鉸

–磚牆→等值斜撐模擬

– RC牆→等值寬柱模擬

• 以 ETABS軟體分析建築物之容量曲線• 以 ETABS軟體分析建築物之容量曲線

• 將建築物之容量曲線轉換為容量震譜求得
性能目標地表加速度
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臺灣耐震評估方法
• TEASPA

– Taiwan Earthquake Assessment for Structures 
by Pushover Analysis

臉書粉絲專頁：
https://www.facebook.com/groups/1420428518211927/
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• SERCB
– Seismic Evaluation of Reinforced Concrete 

Building

https://www.facebook.com/groups/1420428518211927/

技術交流網頁：
http://sercb.dyndns.org/SERCBWeb/Default.aspx



TEASPA分析方法所需工具

• CSI ETABS
(8.0 以上版本)

• MATLAB或 MCR

Installer
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TEASPA 耐震評估方法
• 討論區

• 最新活動

• 檔案下載
– 技術手冊

– 示範例模型

– 講習會簡報

https://www.facebook.com/groups/1420428518211927/

– 講習會簡報

– MCR Installer
• 32 位元

• 64 位元

– 輔助分析程式
• 32 位元

• 64 位元
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技術手冊

示範例模型

講習會簡報

輔助分析程式

MCR Installer



分析模型分析模型
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TEASPA 分析流程
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建立分析模型時所需資料

• 結構圖說：

–平面圖ǵ立面圖ǵ配筋圖ǵ結構平面圖…

• 外觀照片：

–正面ǵ背面ǵ左右側面…

• 材料強度：• 材料強度：

–鋼筋ǵ混凝土ǵ紅磚ǵ水泥砂漿…

• 現場勘查：

–建築物現況ǵ磚牆尺寸ǵ窗台高度…
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平ǵ立面圖
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配筋圖
柱編號 C1 C2 C3

斷面

主筋
4-D22

8-D19
6-D16

4-D19

4-D16

箍筋 D10@25 D10@25 D10@25

尺寸 30×50 24×30 36×36

單位：cm

12

尺寸 30×50 24×30 36×36

梁編號 G1 G2 G3

斷面

兩端 中央 兩端 中央 兩端 中央

主筋
4-D19

2-D16
8-D22 10-D22

箍筋 D10@25 D10@25 D10@25

尺寸 24×60 30×60 30×90



結構平面圖
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柱：1C1ǵ1C2ǵ1C3
梁：1G1ǵ1G2ǵ1G3ǵ1G4ǵ1G5ǵ1G6ǵ1G8ǵ1G9ǵ1G10ǵ1G11ǵ1G12ǵ1G13
版：1S1ǵ1S2



建築物外觀照片
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標的物基本資料
• 地上三層之鋼筋混凝土建築物，每層高度為

3.6 公尺

• 教室外單側有走廊，但走廊外無柱

• 長向長度為 53.5 公尺ǵ短向為 10.2 公尺

• 長向有 90 公分高之窗台，教室間設置 1B 隔
間磚牆間磚牆

• 材料強度
– 混凝土抗壓強度 f’

c = 160 kgf/cm2

– 主筋與箍筋降伏強度均為 fy = 2800 kgf/cm2

– 紅磚抗壓強度 fbc = 150 kgf/cm2

– 水泥砂漿抗壓強度 fmc = 150 kgf/cm2

15



模型建立模型建立
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確認單位

• 調整單位為 kgf-cm
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開始建立模型

• File → New Model
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1.繪製格線
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1-1調整格線間距
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1-1調整格線間距
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1-1調整格線間距

• Edit → Edit Grid Data

視窗範圍內任意位置
點選滑鼠右鍵
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1-2調整樓層高度
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編輯樓層名稱與高度



1-2調整樓層高度

• Edit → Edit Story Data

視窗範圍內任意位置
點選滑鼠右鍵
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編輯樓層名稱與高度



完成格線繪製
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2. 新增材料性質

• Define → Material Properties
快捷列
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混凝土強度：160 kgf/cm2

主筋強度：2800 kgf/cm2

箍筋強度：2800 kgf/cm2



2.新增柱ǵ梁斷面

• Define → Frame Sections
快捷列

1FLC1

EQ
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x
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3.繪製柱ǵ梁

• 選擇柱斷面 (以1FLC1為例)

繪製前確認所在樓層 (1FL)

快捷列
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4.新增樓版

• Define → Wall/Slab/Deck Sections
快捷列
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5.繪製樓版

• 選擇樓版斷面 (以1FLS1為例)

繪製前確認所在樓層 (1FL)
快捷列
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3D模型樣貌
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6.設定垂直載重
• 進行側推分析時，建議考慮之垂直載重應包含設
計靜載重加上 1/2設計活載重

• 本案例校舍設定 1/2設計活載重為 150 kgf/m2

確認單位為 kgf-m
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建築技術規則建築構造編第十七條：

建築物構造之活載重，因樓地版之用
途而不同，不得小於以下所列：

教室：250 kgf/m2

圖書館：600 kgf/m2



7.設定基礎邊界條件

• Assign → Restraints (Supports)
快捷列
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8.設定為剛性接頭

• Assign → Frame/Line → End (Length) 
Offsets 

將梁柱接頭部分視為剛體：
Rigid zone factor=1，
預設值為 0
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9.設定剛性樓板

• Assign → Shell/Area → Diaphragms 

為簡化低矮型校舍結構物之
側推分析，將樓版假設為剛
性樓版
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性樓版



10.撓曲勁度折減

• Select → by Line Object Type
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10.撓曲勁度折減

• Assign → Frame/Line → Frame 
Property Modifiers 

柱構件折減 0.7
梁構件折減 0.7
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快速建立模型之技巧

• Edit → Replicate
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設定非線性鉸設定非線性鉸
• ETABS內建
• 自行定義
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ETABS內建之非線性鉸

• 依據 FEMA 273及 ATC-40之建議，內建
四種非線性鉸：

1. 軸力非線性鉸 (axial hinge)：P

2. 與軸力互制之彎矩非線性鉸 (P-M-M hinge)：
PMM

3. 彎矩非線性鉸 (moment hinge)：
M3 (X向)ǵM2 (Y向)

4. 剪力非線性鉸 (shear hinge)：
V2 (X向)ǵV3 (Y向)
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自行定義非線性鉸

• ETABS .e2k 模型檔

• TEASPA輔助分析程式

• 輔助程式共用輸入檔
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剪力非線性鉸參數 軸力非線性鉸參數彎矩非線性鉸參數



TEASPA輔助分析程式

�Win 32位元

• [程式] TEASPA 32 位元 (版本 2014.4.25)

– BWPHǵCOLPHǵSWPHǵPGA

• [程式] Windows 32 位元 MCR Installer

�Win 64 位元

• [程式] TEASPA 64 位元 (版本 2014.4.25)

– BWPHǵCOLPHǵSWPHǵPGA

• [程式] Windows 64 位元 MCR Installer
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TEASPA輔助分析程式

• 自動計算磚牆構件非線性鉸程式

– BWPH.exe

• 自動計算梁柱構件非線性鉸程式

– COLPH.exe

• 自動計算 RC牆構件非線性鉸程式• 自動計算 RC牆構件非線性鉸程式

– SWPH.exe

• 自動計算性能目標地表加速度程式

– PGA.exe

43



輔助程式共用輸入檔 (*.txt)

• 技術手冊 (NCREE 13-023)附錄 B：
耐震၁細評估輔助分析程式使用說明

$ BRICK WALL PROPERTIES

$ BEAM PROPERTIES

$ BEAM DATA

$ COLUMN PROPERTIES

BWPH
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$ COLUMN PROPERTIES

$ COLUMN DATA

$ AXIAL LOAD

$ SECTION PROPERTIES

$ RC SHEAR WALL PROPERTIES

$ SECTION PROPERTIES

$ BUILDING PROPERTIES

$ SITE SPECTRUM PARAMETER

COLPH

SWPH

PGA



柱ǵ梁桿件之模擬與設定柱ǵ梁桿件之模擬與設定
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COLPH.exe



柱之破壞模式

撓曲ǵ撓剪
剪力
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雙曲率柱側變位之發展歷程

主
筋
降
伏

撓
剪
破
壞

軸
向
破
壞
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柱端部產生
明顯剪力斜
裂縫

柱軸向承載
力喪失



Load Deflection Curve due to Flexure
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Load Deflection Curve due to Flexure
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Load Deflection Curve due to Flexure
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dc：核心混凝土深度
(箍筋中心到中心距離)



撓剪破壞非線性鉸參數

SFM

M
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yna
H H

∆∆
= −Point Moment / SF Rotation / SF

A 0 0

B min(My/Mn, 0.95) 0

C 1 a

D 1 b

E 0 c Moment SF Mn
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Load Deflection Curve due to Shear
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n c sV V V= +• Lateral strength of double 
curvature column
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Load Deflection Curve due to Shear

∆
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剪力破壞非線性鉸參數

Force SF

V

∆

Point Force / SF Disp / SF

A 0 0

B 1 0

C 0 d

D 0 10d

E 0 10d

Force SF Vn

Disp SF H

min ,0.04ad
H

∆ 
=  

 

Disp. SF
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柱彈性行為模擬

彈性勁度
折減
0.7E I

V

0.7EcIgΔ

構材材料性質
Ec, Ig
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柱非線性行為模擬

V

Δ

撓曲與撓剪之
非線性行為

彎矩非線性鉸

56

Δ

V

Δ

剪力破壞行為

剪力非線性鉸



梁之非線性鉸設定
• 校舍結構之梁常與樓板連接形成 T 型梁，
因此梁的模擬應考慮 T 型梁之行為

• 技術手冊第三版依據 ASCE 41-06 所建議
之梁非線性鉸參數進行設定

• 設定 T 型梁非線性鉸時，因斷面呈 T 型不
對稱之緣故，必須注意其非線性鉸因正負對稱之緣故，必須注意其非線性鉸因正負
彎矩的差異性，因其斷面呈 T 型不對稱之
緣故
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T 型梁有效翼緣寬度

1. T 型梁翼緣之有效版寬不得超過၀梁跨度之1/4；梁腹每
側懸出之有效翼緣寬度不得超過翼緣厚(版厚)之8倍或၀
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2. 梁僅一側有翼緣者，其有效懸出翼緣寬度不得超過၀梁
跨度之1/12ǵ翼緣厚(版厚)之6倍或၀梁與鄰梁間淨距之
1/2Ƕ

2 3
2 3min( / 4, min(8 , ) min(8 , ))

2 2
E w

S S
b L b t t= + +

側懸出之有效翼緣寬度不得超過翼緣厚(版厚)之8倍或၀
梁與鄰梁間淨距之1/2Ƕ

1
1min( , 6 , )

12 2
E w w w

L S
b b b t b= + + +



梁彎矩非線性鉸參數

SF

M

M

θ

bal

ρ ρ

ρ

′−
 箍筋 

cw fdb

V

′27.0
 a b c 

ʀ0.0 有圍束 ʀ3 0.025 0.05 0.2 

ʀ0.0 有圍束 ʁ6 0.02 0.04 0.2 

ʁ0.5 有圍束 ʀ3 0.02 0.03 0.2 

ʁ0.5 有圍束 ʁ6 0.015 0.02 0.2 

ʀ0.0 無圍束 ʀ3 0.02 0.03 0.2 

ρ：梁斷面受拉鋼筋比
ρ’：梁斷面受壓鋼筋比
ρbal：梁斷面產生平衡應變狀態之鋼筋比

Rotation SF

θ

彎矩非線性鉸
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ʀ0.0 無圍束 ʀ3 0.02 0.03 0.2 

ʀ0.0 無圍束 ʁ6 0.01 0.015 0.2 

ʁ0.5 無圍束 ʀ3 0.01 0.015 0.2 

ʁ0.5 無圍束 ʁ6 0.005 0.01 0.2 Point Moment / SF Rotation / SF

A 0 0

B 1 0

C 1 a

D c a

E c b



梁剪力非線性鉸參數

SF

P

P

∆

箍筋間距 a b c

箍筋間距 ≤ (d/2) 0.003 0.02 0.2

箍筋間距 > (d/2) 0.003 0.01 0.2

d：有效深度
(構材最外受壓纖維至受
拉鋼筋斷面重心之距離)

Disp.SF

∆
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Point Force / SF Disp / SF

A 0 0

B 1 0

C 1 a

D c a

E c b

剪力非線性鉸



極短柱之模擬與設定極短柱之模擬與設定
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COLPH.exe



極短柱之剪力強度

• 對於鋼筋混凝土構件之剪力強度，第二版
係參酌 ACI 318規範公式以提出建議，但
若為極短柱 (高寬比≦2 者)，剪力強度之估
算並不準確，恐高估鋼筋貢獻之剪力強度Ƕ

• 第三版採用軟化拉壓桿模式 (Softened • 第三版採用軟化拉壓桿模式 (Softened 
Strut-and-Tie Model, SST)，做為前述剪力
強度之計算，使得極短柱剪力強度之估算，
更趨合理Ƕ
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RC短柱受剪破壞之耐震評估研究

Ductile 

(D)

黃益堂ǵ黃世建，Ȩ鋼筋混凝土短柱受剪破壞之耐震
行為曲線研究ȩ，國家地震工程研究中心研究報告，
NCREE 08-027，2008Ƕ

(D)

Non-ductile 

(N)
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Ductile (D) Non-ductile (N)

技術手冊第二版評估結果
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極短柱之剪力非線性行為

suV

scr
V

B：剪力開裂點

Vscr以 ACI牆開裂
公式計算
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極短柱之剪力非線性行為

suV

scr
V

C：剪力極限點

Vsu以 SST計算
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δ su
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scr
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δ δ δ= +
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H IE
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極短柱之剪力非線性行為

D：剪力殘餘強度點

Vsp= 0

suV

scr
V
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δ su
δ spδ

scr

δ δ= +sp su rH

位移係數 r可參考ASCE 41-06建議之
非線性轉角係數



SST模型計算 D區剪力行為

Ductile 

(D)

Non-ductile 

(N)

李翼安ǵ邱聰智ǵ蕭輔沛ǵ黃世建，Ȩ鋼筋混凝土短柱受剪破壞之耐震評估研究ȩ，
結構工程期刊，第29卷第1期，2014年3月Ƕ 68



側力-位移曲線差異比較

撓剪塑鉸

二版 三版

h

L 2>
h

L

69

撓剪塑鉸

極短柱
剪力塑鉸
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�一般柱有機會發展強度



磚牆桿件之模擬與設定磚牆桿件之模擬與設定
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BWPH.exe



磚牆構件之非線性鉸計算

1. 磚牆行為之模擬

• 成大許茂雄教授進行一系列磚牆研究，建議磚
牆可以一等值受壓斜撐進行模擬，၀斜撐必須
與磚牆具有相等之勁度與強度，其端點與構架
鉸接Ƕ

• 以斜撐上之軸力非線性鉸表現磚牆之破壞行為Ƕ• 以斜撐上之軸力非線性鉸表現磚牆之破壞行為Ƕ

2. 磚牆壓力非線性鉸計算依據

• 建築物磚構造設計及施工規範 (2008)
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磚牆等值斜撐模型
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NCREE建議曲線



磚牆臨界破裂角

1. 英國式
砌法

2. 法國式
砌法

73理論上裂縫將會延灰縫間發展，實際上…

3. 二໩一丁
砌法

4. ໩砌法



Cracks of brick masonry

brick Splitting 

of brick

Splitting 

of mortar
crack
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brick

mortar

Sliding 

of mortar

(Taiwan masonry building code, 2007) 

1. 豎向灰縫的劈裂裂縫
2. 豎向劈磚的劈裂裂縫
3. 水平灰縫的滑移裂縫



四面圍束牆：Ultimate strength 

( ) ( )0.45n f b b mbt b bV W T f H Tτ= × + ×
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75

u
∆ 2

u
∆

n
V

r
V

(b)  NCREE

Vn

Wb

Hb

θc



四面圍束牆：( ) tanb b cH W θ>

( ) ( ) ( )
0.45 0.45

0.45 tan tan
2

mbt bt
n f b b mbt b c b b b c b

f f
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三邊圍束磚牆：

非圍束部份磚牆
無法形成階梯狀
對角斜撐機制

bb

mbtfbbn

HθWH
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tan5.0=
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磚牆殘餘強度點之強度與位移

根據試驗之觀察，磚牆約在達到約兩倍水平極
限位移時，磚牆強度會衰減至水平殘餘強度

磚牆之最大水平位移可參考試驗結果並保守考
慮取牆高之2.0%為限制
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四面圍束磚牆實驗驗證
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邱聰智ǵ黃世建等，中華民國第十一屆結構工程研討會，2012年9月，Paper No. 13020



四面圍束磚牆實驗驗證
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砂漿強度：
L為7 MPa； T為10 MPa



三面圍束磚牆實驗驗證
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Yi-Hsuan TU (2011)



試體A：單向側推
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施力端

Yi-Hsuan TU (2011)



試體AC：雙向側推
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施力端

Yi-Hsuan TU (2011)



試體C：單向側推
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Yi-Hsuan TU (2011)

施力端



試體B：單向側推
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Yi-Hsuan TU (2011)

施力端



試體BC：雙向側推
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V
=
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Yi-Hsuan TU (2011)



側推分析法之檢核要໨
為瞭解Ȩ現況ȩ或Ȩ補強後ȩ之၁細評估結
果與分析模型設定一致，可透過下列檢核要
໨加以確認：

1.結構系統模擬及設定
2.柱軸力檢核2.柱軸力檢核
3.非線性鉸參數檢核
4.非線性鉸位置檢核
5.最大基底剪力檢核
6.破壞模式檢核
7.性能目標地表加速度檢核
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結論

• 非線性鉸參數可依技術手冊內容自行計算
後逐一輸入，輔助分析程式係簡化非線性
鉸設定之處理程序，惟使用者應瞭解文字
輸入檔各欄位之定義

• 結構分析模型之設定應與現況接近，可利• 結構分析模型之設定應與現況接近，可利
用檢核要໨加以確認分析結果是否有異

• 非線性鉸參數影響側推分析結果甚鉅，應
確實檢視非線性鉸設定是否正確無誤
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• 經評估耐震無疑慮151棟校舍中，有結構性破壞計有1棟，占0.7%
• 經評估耐震有疑慮且已補強58棟校舍中，無結構性破壞
• 經評估耐震有疑慮待補強85棟校舍中，有結構性破壞計有18棟，占21%

150

90

120

150

校

舍

臺南市0206地震震損校舍之統計

• 經評估耐震無疑慮：經初步評估、詳細評估或補強設計解除列管
• 經評估耐震有疑慮且已補強：完成補強或拆除程序
• 經評估耐震有疑慮待補強中：尚待執行補強或拆除作業
• 本圖僅統計歸仁區、永康區、⇕門區、玉井區、佳里區、山上區、善⇔區、麻豆區、左鎮區之校舍

1 0
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有結構性破壞 無結構性破壞 有結構性破壞 無結構性破壞 有結構性破壞 無結構性破壞

經評估耐震無疑慮 經評估耐震有疑慮，已補強 經評估耐震有疑慮，待補強中
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簡報結束，敬請指教


